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T heMAGIC User's Manual

This is the Help File for the Magic Tool Suite for Windows. It uses the standard Windows Help so it is pretty
self-explanatory. You can use the panel to the left to scan through the table of contents. To select a part, chapter,
or section click on it. To use the index click on the index tab and type your search query into the text field. Make
a selection from the list and press the 'Display' button. If there are more than one pages linked to the keyword you
selected then a dialog box will appear prompting you to choose which page you would like to view. Within the
pages there are many links which will take you to a related page. If you find any dead links please email them to
rn ag ic.s upport(ti) atk.coni.
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Preface

This User's Manual documents the 2004-2006 versions of MAGIC2D and MAGIC3D. MAGIC2D is a



two-dimensional code and MAGIC3D is its three-dimensional counterpart. The same Manual applies to both.
You will encounter references to "2D simulations," which currently can be performed only with MAGIC2D, and
to "3D simulations," which currently can be performed only with MAGIC3D. With this manual, we continue
toward the goal of unification of the two codes. Virtually all the algorithms and material models are available in
both MAGIC2D and MAGIC3D. While some features are currently available in only one of the codes, our goal is
to make all features universal. The User's Manual has been rewritten to reflect various command changes, new
models and algorithms.

Mugman: The MAGIC Tool Suite Manager.

The MAGIC Tool Suite Manager is the browser for viewing the electronic MAGIC User's Manual. It

allows the user to examine the manual by part or by individual command. In addition, it includes a set of example
files that can be exercised directly from the Tool Suite Manager. The Tool Suite Manager will start MAGIC2D or
MAGIC3D for the particular example selected. In addition, it allows the user to browse through the MAGIC
tutorials that are also supplied in electronic form.

Bug fixes and New and Revised Commands.

"* Added to IMPORT.. SPOTS options (MAGIC3D only). This is make it easier to inject multiple beam
spots at an import plane.

"* Added MOVIE option + timing controls to OBSERVE. Also, added CODEC control for MOVIES that
are converted to AVI. The default CODEC was changed to MSVIDEO1.

"* Added default EXTRACT and SAVE names for diagnostics.
"* Added beam axis direction to FOIL command. This relaxes the restriction on foils being 1 cell thick

and conformal. Change is not backward compatible, users will need to make adjustments to earlier
simulation files.

"* Corrected a problem that occurred when OBSERVE INTERVAL n>l. The diagnostic QOF-SIGNAL
would fail if the user examined the diagnostic prior to the end of the simulation.

"* Corrected a problem in Magic3d, for EMISSION BEAM .. TIMING ktime. When ktime was greater
than 1, the model was creating ktime*current. Particles were created on each time step.

"* Add NOKILL option to CONDUCTORS (MAGIC3D only). This allows particles to stream
ballistically through a thin conductor. This should only be used as an internal conductor option.

"* Altered FOIL command so that it now requires specification of the beam transit axis. This then permits
any volume shape to be used in defining a FOIL.

"* Added MOVIENAME option to CONTOUR, RANGE, PHASESPACE, and VECTOR.

"* Mugman modified to allow remote update of parallel cluster cpu's to use the identical version of
MAGIC.

* Added TWOPORT option to SMATRIX. This is used only for cold tests to get the complete Smatrix.
Assumes that there are two ports at which incoming waves may be injected.

* Repaired IMPORT failure to trap the error that occurred when the beam energy was not defined.

* Repaired BEAM emission shape profile problem.

* Added additional data options for OBSERVE SMATRIX. These are: Sl 1_REALIMAGINARY,
S1 IMAGNITUDEPHASE, S21_REAL_IMAGINARY, and S21_MAGNITUDEPHASE.

* Extract data option now decimates extracted data according to the selected interval. Thus if you extract
with data interval 'n', you get every nth datum into the extract file. Most useful for OBSERVE.

* Fixed MAGIC2D - intermittant emission with secondary emission.

* Fixed a problem with MAXWELL Quasi-Static, resulted in inproper evaluation of functions with the



time argument.
"* Fixed MAGIC2D and MAGIC3D EMISSION SECONDARY, the default secondary electron energy

distribution was poorly resolved and a gave a vary obvious stairstepped sample. Increased the

sampling resolution.
"* Fixed parallel sew of VECTOR and CONTOUR plots in MAGIC3D.

"* Fix problem with PORT normalization in MAGIC3D. Did not properly check to ensure Voltage

measurement of V/m measurment lay within the Port area. Only caused problems if normalization was

outside of PORT area
"* Added volume type ROTATE to MAGIC3D. Designed for use in cartesian coordinates. Command

looks like: "Volume name ROTATE area stencil PointO0axis of rotation Pointlaxis of rotation;"

"* Added to MAGIC3D PRESET command the magnetic field type "MAGNUMBNEW", (new data

format for Magnum code.
"* Fix problem with IMPORT when used with parallel processing in MAGIC3D.

"* Merged the table and species features. This allows the 3d particle viwer to be used in ReView 3d
viewer.

"* Added a NORMALIZATION options to the VECTOR command. This allows a fixed scaling to be

applied to all the vector plots.
"* Corrected a problem with MAGIC3D Phasespace interactive selection. Shows only the selected plots

and only on kinematic timesteps.

* Corrected a problem with the PHASESPACE ... WINDOW option. The choices of windows for Q,
KE, and GAMMA were not available.

"* Added automatic processing of movie bitmap files into an avi-file.

"* Corrected a problem in MAGIC2D, where PRESET with ADD option replaces rather than
superimposes the fields.

"* Corrected a problem with the TABLE command for column style output.
"* Corrected a problem with the TEMPERATURE option of EMISSION EXPLOSIVE for MAGIC2D.
"* Corrected a problem in MAGIC2D for OUTGOING that causes a failure if the boundary exceeds 199

cells in length.
"* Added an OBSERVE SMATRIX diagnostic for cold tests.
"* Corrected an intermittant problem with Magic2D, associated with PORTS ands SYMMETRY

PERIODIC boundaries for large numbers of grid mesh.

"* Corrected a problem with IMPORT FILE in Magic3D. When timestep of the FILE data is different
from the mesh generated timestep, the current scaling of Contour plots was incorrect.

"* Reviseed MUGMAN so that uses a local copy of a MAGIC executable in the input file folder, rather

than the copy in the MAGIC Tools folder.

"* Added option to AUTOGRID, allowing you to EXTEND a grid partially generated with the GRID

command, and then completed with the AUTOGRID command.
"* Corrected an error in RANGE ... FFT. Changes the display so that is uses wave-number rather than

inverse wavelength.
"* Added another option to IONIZATION ... EMPIRICALBETAMIN.

"* Corrected a problem with the PRINT screen option.
"* Secondary emission failing when the primary charge is too small in Magic2d. This problem has been

repaired. Symptom was no secondary particles.

"* Fixed bug in CONTOUR HISTOGRAM for MAGIC3D

* Added GAS CONDUCTIVITY model for MAGIC2D

SB-fitctorv Klvsfron teniplate.

* An EMISSION [option] has been added [FIXEDCHARGESIZE q].
* Please note that this version uses a NEW set of registry entries, that are not compatible with version



7.00 and earlier.
"* Uninstall earlier versions of MAGIC prior to installing this one. Piecemeal update of the executables is

not available for this version.
"* Added Emission Temperature for Explosive emission.
"* Added MUGMAN new features. Includes treeview rendering of the input file, also colored text format

option to identify commands and keywords.
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Command Index

Quick links:
A, B, CD, LE, , L , L, !, K, L, M,
N, O,P, Q, R, S, T, U, V, W, X, Y, Z

SnamelistS OBSERVE [options]
OBSERVE INTERVAL

OBSERVE CIRCUIT
AR EA OBSERVE COLLECTED

ASSIGN OBSERVE EMITTED

AUTOGRID OBSERVE FIELD
OBSERVE FIELD ENERGY

BI.OCK / ENDBI.ROCK OBSERVE FIELD INTEGRAL
OBSERVE FIELD POWER

CABLE OBSERVE FILE
CA PACITOR OBSERVE IM PEDANCE
CA LI., / RETU RN OBSERVE ]INDUCTOR
CH A RACT ER OBSERVE INTERVAL
CI RCUIT OBSERVE IONIZATION

COILS OBSERVE NEUTRAL GAS
COM MAND OBSERVE PARTICLE STATISTICS
COMMENT/ C / Z/! OBSERVE RESONANT PORT

CONI)UCTANCE L OBSERVE RESISTOR
CONDUCTOR L OBSERVE SECONDARY
CONTINUITY I OBSERVE SMATRIX
CONTOU R [OPTIONS] OBSERVE SPACE HARMONIC
CONTOUR FIELD OBSERVE TRAMLINE
CONTOUR IIISTOGRAM OBSERVE TRANSFORM
CON TOuR NEUTRAL GAS OUTGOING
CONTROL
CUIRRENT SOURCE PARALLEL GRID

PARAMETER
DAMPER PHASESPACE
DIELECTRIC PHOTON

DELIMITER POINT

DISPLAY POISSON
DO /ENDDO POLARIZER

DRIVER POPULATE
DUMP PORT
DU RATION I PRESET

ECHO / NO ECH 0 RANGE [optionsl
EIGENMODE RANGE FIELD

ELSE, ElSEIF, ENDIF RANGE FIELD INTEGRAL
EMISSION loptions] RANGE FIELD POWER
EMISS ION BEAM RANGE HISTOGRAM
EMISSION EXPLOSIVE RANGE NEUTRAL GAS
EMISSION GYRO I RANGE PARTICL•E
EMISSION HIGH FIELD I RANGE TRAMLINE
EMISSION PHOTOELECTRIC REAL
EMISSION SECONDARY RESISTOR

EMISSION THlERMI ONIC RESONANT PORT



E M IT
EXPORT SHIM

SPECIES
FllM START / STOP
FOIL STATISTICS
FREESPACE SURFACE LOSS
FUNCTION SYIMMETRY

SYS TE M
GAS CONDUCTIVITY
GRAPHICS I TABLE FIELD
GRID ORIGIN TABLE PARTICLES
GRID EXPLICIT TFAGGING
GRID UNIFORM TERMINATE
GRID QUADRATIC I TIME STEP
GRID PADE I TIMER

TRAMIINE
MEADER

VECTOR
IF/ ELSEIF / ELSE / ENDIF VIEWER

IMP ORT VOID
IN I)tUCTOR VO LUM E

INTEGER VOLUME ANN ULAR
IONIZATION VO LIUM E an nular section

VO LUM e conE
JOIN VO LUM e conformal

VOLUMe cylindrical
KEYBOARDI I VOLUMe extrudeld

i VO LUMNe functional
LINE VO LUM e hElical

LIST VO UIUMe lath E
LOOKBACK VO)LUNIe parallel~epipedal
LORENTZ VO LUNI e prva mid

VO)LUMhe rhombus

MARK VO LIUMe rotatE
MATCH VOLUMe spherical
MATERIAL VOLUMe tetrahedron
MAXWELL CENTERED VO LUM'e toroidal
MAXWELL FIXED VO L1UM e wedgE

MAXWELL QUASI NEUTRAL VO)LTAGE
MAXWElL QUASI STATIC
MAXWELL IIIGHI Q Z
MAXWE1.L BIASED
MCLDIALOG
MODE



System Requirements:

Windows NT, Windows 2000, or Windows XP

90 MHz or above

64 Mb RAM, bare minimum

A USB port for the Hardware Key (for licensed version only)



Export Compliance Information and this Product

Warning: This information may be controlled for export by the Arms Export Control Act (Title 22, U.S.C.,
App. 2751 et seq.) or the Export Administration Act of 1979, as amended, Title 50, U.S.C., App. 2401 et seq.
Export of this information to a foreign person inside or outside the United States must be in accordance
with the International Traffic in Arms Regulation (ITAR) or Export Administration Regulations (EAR).



The Sentinel System Drivers

The Sentinel System Drivers provide a communication path between MAGIC and the Sentinel key. It is

necessary to install the drivers if and only if you have been supplied a hardware key with the Magic Tool

Suite purchase. For demonstration copies of the Magic Tool Suite you need not install the drivers. Note!

The demonstration copies of Magic are hardware locked to run only tiny problems. For full size simulations,

you must license the software to obtain a hardware key.

Quick Installation Procedure for

The Sentinel System Drivers for the MAGIC Hardware Key

1. Using Windows Explorer go to the MAGIC Tool Suite Installation Folder. If you installed on the C

Drive the path should be: C:\Program Files\MAGIC Tools\SentinelDrivers" and your explorer

window should look like the following figure. Using your mouse highlight the file

al-11) ow 3S )).2. c.2xe and run it.

File Edit View Favorites Tools Help

i EBack " .--- Search Folders

Address C'rogram Files'aoic Tools',Sentin elriers Go 1Norton AntiVirus ,

Folders X _Name 
si- ize I Type

----------. . .. I .InstallSen nel.rtf 2078K- - RichTextFornar1E4 'j Magic ToolsH ,[£ i.•lExaplesd i•Jit~l~~i,'•.•..11,•t.••.•4,022 KB Application

R• [ Examples3d l

i M. r v W,-,rk.

N '.ev%, ,Version
i• Old-V,,er siorn

P. FosterAssistance ]

t- -- j' Sent~nelDrivers

2. Running this will install the required drivers.

3. To verify the installation of the Sentinel Drivers Open the Control Panel and using the mouse click on

the item "Add/Remove Progorams". You should see a window that resembles the following.



File Edit View Help

J±Control Panel ± i I1 I iii <km ŽJ MIMI
3Com DynamicAccess 'Accessibility Options , "--i Console b Date/Time

SDisplay 'A Find Fast Fonts HP Simple Trax Internet Options
3 Mail and Fax Modems Mouse Multimedia Network
,i PC Card (PCMCIA] 7 PortsrPrinters 4` Regional Settings SCSI Adapters

UPServices _PSounds Symantec LiveUpdate J System CJ Tape Devices

Sets up programs and creates shortcuts.

4. The next screen will be the "Add/Remove Programs Properties" dialog box. Scroll down the display list
and verify that the item "Sentinel System Driver" is present.

,AdR oa - - '. . am- -e .

Install/Uninstall I Windows NT Setup

,.u To install a new program from a floppy disk or CD-ROM
drive, click Install.

Install...

".t• The following software can be automatically removed by
"C"•:; Windows. To remove a program or to modify its installed

components, select it from the list and click
Add/Remove.

Microsoft Windows Media Player 6.4
MSDN Library -Visual Studio 6.Oa
Neato MediaFACE
Norton Anti'Virus 2001
Resolve buffer over run in riched32.dll

Sound Blaster PCI128
Symantec pcAnywhere
VDOLive Player

Add/Remove...

OK Cancel -

5. You are done. At this time you may wish to reboot your computer. Before restarting ensure that the
hardware key has been installed on your computer.

Install the Sentinel MAGIC Hardware Keys



Distribution of this software is limited. Redistribution is not authorized unless prior arrangements

have been made with Mission Research Corporation.

Installing the Hardware Key Sentinel drivers. Using Windows Explorer, find the MAGIC Tools folder
in which you installed the MAGIC Tool Suite. Locate the folder named "SentinelDrivers", run the file

"RainbowSSD5.39.2.exe". Confirm the path information, if requested. Quit when complete.

Installation of Hardware Key (Parallel Port or USB Port Key). Hardware keys are supplied with the

licensed versions of MAGIC. To install the hardware key, you must first turn off your PC.

Parallel Port Key. Attach the hardware key to your PC's parallel printer port, usually labeled "LPTI".

The end of the key to be attached to the port is labeled "COMPUTER" (see Figure). A printer or other
peripheral device can be attached to the other end of the key, if desired.

"'". ¢ U <• I .. .tC ,•.;;

USB Port Key. Insert USB port key is USB port slot.

Restart your PC.
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1. INTRODUCTION

1.1 MANUAL OBJECTIVE

This Manual documents the most recent release of the MAGIC2D and MAGIC3D codes. The codes an(
Manual are usually released annually. The version (month and year of release) is imprinted on the cover of thi
document and on virtually all output from the code. Interim versions of the code may be released withou
documentation to correct errors, to permit use of new algorithms, and to allow beta testing. Users who encounte
errors in the code or Manual are encouraged to communicate these to Mission Research Corporation by fax at (703
3 39-6953 or e-mail at magic@mrcwdc.com.

Insofar as it is possible, the code is designed to be backwards compatible with the Manual. This means tha
features in previous Manuals will probably work in the latest version of the code. Backwards compatibility is th
reason that old input files can continue to run, even though many of the commands are technically obsolete and hay,
been dropped from the Manual. The Manual reflects the future, while the code is a mixture of old and new features

The Manual assumes that the reader may have no prior experience with the code, but that he is acquainte(
with computational physics methods in general and electromagnetic, particle-in-cell methods in particular. There i
little attempt to motivate or even to justify the conventions and algorithms offered. Instead, the focus is upon hov
to use the code, and the user having previous experience with the code may wish to proceed to Part 2.

1.2 MANUAL ORGANIZATION

This Manual consists of nine Parts, and it is further subdivided into 31 Chapters.

Part 1 (Using the Code) is intended primarily fornew users. It focuses on "how to" and is relatively devoid
of theory and derivations.

"* Chapter 1 is the introduction.
"* Chapter 2 describes how to create a simulation. It presents most of the important choices that go into a

simulation and includes cross-references to actual commands. It also presents the most important convention,
and the most common user errors.

"* Chapter 3 describes how to execute the simulation, how to recognize errors, and how to continue the
simulation further in time.

"* Chapter 4 offers an abridged discussion of the MAGIC Command Language (MCL), which includes the use o
constants, variables, and functions, and provides a basis for advanced data processing methods.

"* Chapter 5 discusses the rules of syntax, or how to interpret arguments in the Manual to write commands that
work.

Parts 2 through 7 contain the command descriptions. The Parts and Chapters are organized by function, thbu
making it easy to compare the alternatives available. Each command description includes commandname,
function, syntax, arguments (definitions), description, restrictions, see also (cross-references), references (to
literature), and examples. The Parts are as follows:

"* Part 2 (MCL commands) - variables, functions, do-loops, etc.
"* Part 3 (time and space) - spatial objects (points, lines, areas, volumes) and grids
"* Part 4 (spatial extensions) - outer boundaries and transmission lines
"* Part 5 (properties) conductors, dielectrics, resistive properties, emission processes
"* Part 6 (algorithms) electromagnetic, current-density, and particle kinematics



"* Part 7 (output) - an extensive selection of simulation output types and methods
"* Part 8 (graphics interface) - illustrates how to use the graphics interface and shows the capabilities
"* Part 9 (examples) - has links to 2d and 3d examples, allows you to run these examples from tht

electronic help manual

1.3 SOFTWARE DESCRIPTION

MAGICIlU is an electromagnetic particle-in-cell code, i.e., a finite- difference, time- domain code fo
simulating plasma physics processes, i.e., those processes that involve interactions between space charge an,
electromagnetic fields. Beginning from a specified initial state, the code simulates a physical process as it evolve
in time. The full set of Maxwell's time-dependent equations is solved to obtain electromagnetic fields. Similarly
the complete Lorentz force equation is solved to obtain relativistic particle trajectories, and the continuity equatiol
is solved to provide current and charge densities for Maxwell's equations. This approach, commonly referred to a
electromagnetic particle- in- cell (PIC), provides self- consistence, i.e., interaction between charged particles an(
electromagnetic fields. In addition, the code has been provided with powerful algorithms to represent structurz
geometries, material properties, incoming and outgoing waves, particle emission processes, and so forth. As
result, the code is applicable to broad classes of plasma physics problems.

The MAGIC tool suite includes MAGIC2D, a two- and one-half dimensional code (2D fields and 31
particle kinematics), MAGIC3D, a fully three-dimensional counterpart to MAGIC2D, and ReView[2], a general
purpose post- processor. It reads from the MAGIC standard database format. It can redisplay simulation graphic:
after a simulation is complete. All codes in the MAGIC tool suite are built on an application- independent softwar,
library. This includes the command language interpreter from which the user interface for each code is built and th,
DUMP utility which provides communication between the codes and the database. The use of this library speed;
code development, but more importantly, it helps integrate the system and makes the codes similar to learn and use.

The MAGIC Tool Suite for Windows consists of several software applications. The principle ones are:

,•InputBuilder - This application is an alternative version of the MAGIC Tool Suite Manager, MUGMAN. I
contains a browser for the electronic copy of the MAGIC User's Manual. It also allows the user to launch the tin'
versions of MAGIC2D and MAGIC3D, as well as POSTER. Input files may be edited using the MAGIC Tool Suit
Manager and new ones constructed, saved, and run with the appropriate application. The builder enforces
particular format on input files that make them easier to read and edit. InputBuilder and Mugman are very similar ii
appearance and functionality. If you already familiar with Mugman, you will be able to use InputBuilder in
similar fashion.

MUGMAN - This application is the MAGIC Tool Suite Manager. It contains a browser for the electroni(
copy of the MAGIC User's Manual. It also allows the user to launch the tiny versions of MAGIC2D an(
MAGIC3D, as well as POSTER. The MAGIC Tool Suite Manger includes a set of example input files for both 2r
and 3D, and provides online copies of the MAGIC Training Seminars. Input files may be edited using the MAGI(
Tool Suite Manager and new ones constructed, saved, and run with the appropriate application.

"] MAGIC2DSNG and O MAGIC2DDBL - are the single and double precision versions of MAGIC2D).

MAGIC3D_SNG and MAGICD_DBL - ate the single and double precision versions of MAGIC3D.

4VMAGIC3D_SNG and ~-~MAGIC3DDBL - are the single and double precision versions of MAGIC3D3.



SREVIEWSNG and I REVIEWDBL - are the single and double precision versions of Review, th(
interactive post-processor for the MAGIC database format. This application replaces POSTER.

1.4 STARTING "MUGMAN", THE MAGIC TOOL SUITE MANAGER

Launch the MAGIC Tool Suite Manager as follows:

"• Begin with the Windows START menu button,
"* Select the PROGRAMS menu,
"* Select the MAGIC Tools menu,
"* Click on "Mugman.exe".

The following figure illustrates what this will look like on your monitor.

,- Accessoies

71 Avance Sound ir-L~rzŽer 11

F !nternet Ebpre•
Vii•'indoys fNeda Player-

'J Sear& Lahey-Fujatsu F•r tw. 95 v5.6 1

• He e Supper, ,_ N Ant,'ous i qI mac2d [oz-t:,: C:'ýr,.•ra

.z Ru .. ,1 Wnterate- v4.0 1 magic2d_ ig.exe

,1*_ Muosoft Vsual 68kc 6;0 " ma•cd bl.e.xe

MizI~ 711osoft Offie Tcols 0 al3ýSý_x

Once the MAGIC Tool Suite Manager starts, it displays a window like the following one. This window may b
resized just like any other Windows application to provide a bigger viewing area. Mugman is a text editor witl
built-in features that make it easier to construct, edit, and run Magic Input files.

t .. . ._7,7 7 1 1-Fk Edt 5^irch kcr'~~-'-m*~~ Ht p

V I I'

-AUTOGRID ^

D ,I -WP16h'_ 1- X)

• DUMP >

> Lrt:76 G-14:9 ~ JM 116

The text editor (right-side window) in Mugman only allows you to edit one file at a time. The outline view (left
side window) lists all the commands in the file, if the Command tab is the selected tab at the top of the outlin,
view. Clicking the plus sign to the left of a command in the outline view opens branches to all lines using tha
command. Double-clicking a branch in the outline view moves the text editor cursor to the corresponding comman(



line. Each time you exit Mugman, it remembers the name of the file you are currently working on, an
automatically reopens this file the next time. The name and location of the current file is displayed in the title bar a
the top of the window. The File, Edit, and Search menus provide the standard commands found in most tex
editors. These commands will be explained in the Menus section below. The Options menu allows you to chang(
the appearance and behavior of Mugman. The Display menu provides refreshing of the text color, and of the outlin
view. The Help menu provides access to the Magic Manual, an extensive help manual that contains beginner'
information, a full list of the Magic commands and their arguments, explanations of certain algorithms used ii
Magic, and access to a large number of example simulations that are a good starting point for building your owi
simulations.

1.4.1 The Mugman Toolbar

The Mugman Toolbar, located directly underneath the menu, contains buttons that perform the most commonly use(
editor functions in Mugman, as well as buttons to launch Magic and Review. The table below shows each button'
function.

Toolbar Button Functions and Descriptions

Button Name Action

iManual Opens the Magic Users Manual in a separate window. Pressing

this button is the same as selecting Help menu item Magic l telp
Manua_ or pressing function key F 1.

Open Open a new file. Mugman can only edit one file at a time, so

you will be prompted to save changes before the current file is
closed. Pressing this button is the same as selecting File menu

item 0 jOpn.

Save Save the currently open file. If the file is unsaved, a dialog will
prompt you to select a location and filename. Pressing this
button is the same as selecting File menu item Save.

(_ Open Command Open a command dialog related to the current text command, to
Assistant assist in replacing the current command line (if the command

word was selected in the text editor) or in adding a command

line. Do not use this button for commands BLOCK,
MCLDIALOG, or $namelist, as those command lines must be
typed into the text editor window by hand. Pressing this button

is the same as selecting Edit menu item Command Assistant or
pressing F2.

Show/Refresh Open or refresh the outline view. When a command dialog is

Outline View used to replace or add a command line, the outline view

automatically refreshes. So, this refresh button only has to be

used if text was typed into the text editor window by hand.
Pressing this button is the same as selecting Display menu item

Re [resh Outlin e' View or pressing F4.

Open Parallel Open a dialog box that allows you to choose which computers
Processing in your network will be used for a parallel run of your



Dialog Box MAGIC3D file. All of the computers on your network must
have been previously listed by selecting Options menu item
"Configure Parallel Cluster ... ".

Magic2D-Sng This button starts MAGIC2D single precision. If the open file
in Mugman is a .m2d or .mgc file, it will be used as the input
file.

Magic3D-Sng This button starts MAGIC3D single precision. If the open file in
Mugman is a .m3d or .mgc file, it will be used as the input file.

ReViewSng This button starts ReView single precision. If the open file in
Mugman is a .toc file, it will be used as the input file.

I Magic2DDbl This button starts MAGIC2D double precision. If the open file
in Mugman is a .m2d or .mgc file, it will be used as the input
file.

1W Magic3DDbl This button starts MAGIC3D double precision. If the open file
in Mugman is a .m3d or .mgc file, it will be used as the input
file.I ReViewDbl This button starts ReView double precision. If the open file in
Mugman is a .toc file, it will be used as the input file.

SOpen Log File Open the log file that resulted from running the MAGIC2D or
MAGIC3D input file currently residing in the text editor.
Pressing this button is the same as selecting File menu item
Lp)n L .oi.

Wordpad This button starts the wordpad text editor. This is useful for
viewing RTF files, since Mugman can only display them.

i-_ Indent Selected Indent/Unindent the selected text editor lines.
Lines
Print This button opens a print dialog that allows you to set printer

options and print the currently open file in Mugman. Pressing
this button is the same as selecting File menu item Print.

Search This button is used to search the text for a specific word or
phrase. Pressing this button is the same as selecting Search
menu item Find.

Play AVI File This opens a list of AVI movie files in the current folder, and
plays the selected file.

Delete Files This opens a check-list of files in the current folder, and deletes
the user-selected files. Pressing this button is the same as
selecting File menu item LhIctc Fil .

1.4.2 MUGMAN Menu Commands

The Mugman main menu contains seven different groups of commands. If the main menu is not currently
displayed, clicking inside the text editor (right-side window) will cause it to appear. The File, Edit, and Search
menus contain standard text editor commands:



File Menu

New: This will create a new, blank document. Since Mugman can only edit one file at a time, Mugman will clos,
the currently open document before the new document is created. If any changes have been made to the curren
document, the user will be asked if they wish to save their changes before closing the file.

Opecn : This will open a file browser to select a new file to open. If you are looking for a particular type of MAGI(
input or output file, you can select the type in the browser, as shown in the following figure.

Look in: [ 3DFoil .ffIt • ]

'L 63dfoil, msd
L•• • 3dFoil.t~xt

My Recent L1jFoil andFilm.m3d
Documents

Desktop

My Documents

My Computer

My Network File name: " Open
Places ,

Files of type: [All - -] Cancel

Magic [l.mgc;-.m2d;-.m3d]
Magic 2D [(.m2d;x.log]
Magic 3D ['.m3d;'.log)
Review [*.toc;'.obr;x.obi;x.obs)
Log ('.log]
Text (R.txt)
Summary ['.sum)

Opj -en I.,: Open the log file that resulted from running the MAGIC2D or MAGIC3D input file currentl:
residing in the text editor.

[ilVe Il isItor": This will open a dialog that lists the last 20 files opened in Mugman. Select the file to open next ii
Mugman.

Batch lRuns: This will open a dialog for listing the Magic files that you would like to run consecutively.

Save: This will save any changes to the currently open file. If the file is unsaved, a file browser will prompt you t(



select a location and enter a filename.

Save As: This will open a file browser for the user to select a location and filename. If the filename already exists
you will be asked to confirm before replacing the file.

1l)e'tce File:c;: This opens a check-list of files in the current folder, and deletes the user-selected files.

PrinI: This will open a print dialog that allows you to print the current document, setup the page layout, or select
different printer.

Prinat Seccion: This option will only print a selected block of text.

(lIilc lis4orMiniiist): These dynamic items list the last 6 files that have been opened in Mugman. The user car
select one of those files to open next.

Uxit: Quit Mugman. If changes have been made to the currently open file, you will be asked if you wish to savc
your changes before quitting.

Edit, Search and Format Menus

The Edit and Search menus contains the standard commands available in any text editor. The editor supports multi
level undo, which allows you to undo changes made to a file one step at a time. Lines can be selected, and thei
indented/unindented. Commanad A, siý1ant F-2 opens a command dialog related to the current text command, t(
assist in replacing the current command line (if the command word was selected in the text editor) or in adding
command line. Do not use this function for commands BLOCK, MCLDIALOG, or $namelist, as those comman(
lines must be typed into the text editor window by hand. Nw Co n (mia d... provides access to command dialogs
either alphabetically by command name, or by category. Text can also be cut, copied, or pasted to or from othe
programs. The Edit Menu can also be accessed by right-clicking in the text editor. The Search Menu allows you t(
search for a text string in the currently open file, from the current position in the file. You can search either up o
down from the current position, specify an exact or case insensitive match, or search only for a whole word match.
The Format Menu permits selection of font type and size.

Options Menu

The Options Menu allows choices for using the command dialogs, for continuing a command over more than one
text line, for enabling the outline view, for coloring the text, and for listing the parallel computer network. The
Options Menu is shown in the figure below.


